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INTRODUCTION

BIOINFORMATICS

The term “Bioinformatics” was invented by Paulein Hogeweg and Ben

Hesper in 1970as “the study of informatic processes in biotic systems.

It is a hybrid science that links biological data with techniques for
information storage, distribution and analysis to support multiple areas of
scientific research, including biomedicine. It is fed by high-throughput
data generating experiments, including genomic sequence

determinations and measurements of gene expression patterns.

The classic data of bioinformatics include DNA sequences of genes or full
genomes; amino acid sequences of protein; and three-dimensional

structures of proteins, nucleicacids and protein-nucleic acid complexes.

In bioinformatics, data banks are used to store and organize data. Many

of these entities collect DNA and RNA sequences from scientific papers

and genome projects.

The development of efficient algorithms for measuring sequence
similarity is a important goal of bioinformatics. Another goal of
bioinformatics is the extension of experimental data by predictions. A
fundamental goal of computational biology is the prediction of protein

structure from an amino acid sequence.

APPLICATIONS: -

It has application in various science fields and some of the examples are:
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It is used in molecular medicine, drug development, gene therapy,

biotechnology, bio weapon creation, forensic analysis, veterinary science,

personalized medicine, etc....

2. Nucleotides

A molecule that is the basic building block of the nucleic acids DNA and RNA. A

nucleotide is made up of a nitrogen-containing base (adenine, guanine, thymine, and
cytosine in DNA, and adenine, guanine, uracil, and cytosine in RNA), a phosphate I
group, and a sugar molecule (deoxyribose in DNA, and ribose in RNA). DNA and RNA
are polymers made up of many nucleotides.

Structure of DNA. Most DNA is found inside the nucleus of a cell, where it forms
the chromosomes. Chromosomes have proteins called histones that bind to DNA. DNA II
has two strands that twist into the shape of a spiral ladder called a helix. DNA is made
up of four building blocks called nucleotides: adenine (A), thymine (T), guanine (G),
and cytosine (C). The nucleotides attach to each other (A with T, and G with C) to form

chemical bonds called base pairs, which connect the two DNA strands. Genes are

short pieces of DNA that carry specific genetic information.
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3. Web Application

A web application (web app) is an application program that is stored on
a remote server and delivered over the internet through a browser
interface. Web services are web apps by definition and many, although not
all, websites contain web apps.

Web applications do not need to be downloaded since they are accessed
through a network. Users can access a web application through a web browser,
such as Google Chrome, Mozilla Firefox or Safari.

For a web app to Operate, it needs a web server, application server and
database. Web servers manage the requests that come from a client, while the

application server completes the requested task. A database stores any necessary

information.

Some of the tools we used to build Web Application are Google Colab,

Anaconda Navigator, Streamlit, Streamlit Local Tunnel for Google Colab etc.

4. Google Colab
» Python

Python is a set of instructions that we give in the form of a Programme to our

LTI

computer to perform any specific task. It is a Programming language having

properties like it is interpreted, object-oriented and it is high-level too. Due to its
beginner-friendly syntax, it became a clear choice for beginners to start their
programming journey. The major focus behind creating it is making it easier for

developers to read and understand, also reducing the lines of code.

e Features of Python

a. Easy to read and understand

| b. Interpreted language
f -

vU\)UQDJpJ;LJ)LL
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. Object-oriented programming language

. Free and open-source

. Free and open-source

. Versatile and Extensible

. Multi-platform

. Hundreds of libraries and frameworks
Flexible, supports GUI
Dynamically typed

k. Huge and active community

e Python’s Module, Package and Library

What is Module in Python?

The module is a simple Python file that contains collections of functions

and global variables and with having a .py extension file. It is an executable file
and to organize all the modules we have the concept called Package in Python.

TR

Examples of modules:
i. Datetime

ii. Regex
jii. Random etc.

Example: Save the code in a file called demo_module.py

What is Package in Python?

The package is a simple directory having collections of modules. This
directory contains Python modules and also having _init _.py file by which the
interpreter interprets it as a Package. The package is simply a namespace. The

package also contains sub-packages inside it.

Examples of Packages:

i.  Numpy
ii. Pandas (used in project)

T T
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What is Library in Python?

The library is having a collection of related functionality of codes that
allows you to perform many tasks without writing your code. Itis a reusable
chunk of code that we can use by importing it into our program, we can just
use it by importing that library and calling the method of that library with a
period(.). However, it is often assumed that while a package is a collection of

modules, a library is a collection of packages.
Examples of Libraries:

i. Pytorch
ii. Matplotlib
iii. Pygame

iv. Seaborn
v. Sreamlit (used in project)

vi. Altair (used in project)

R

Example:
Importing pandas library and call read_csv method using an alias of

pandas i.e. pd.

> Google Colab :

e Google Colaboratory, or Colab, is an as-a-service version of Jupyter
Notebook that enables you to write and execute Python code through

your browser.

Jupyter Notebook is a free, open source creation from the Jupyter
Project. A Jupyter notebook is like an interactive laboratory notebook
that includes not just notes and data, but also code that can manipulate
the data. The code can be executed within the notebook, which, in turn,

can capture the code output. Applications such as Matlab and
Mathematica pioneered this model, but unlike those applications, Jupyter

is a browser-based web application.
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Google Colab is built around Project Jupyter code and hosts Jupyter
notebooks without requiring any local software installation. But while
Jupyter notebooks support multiple languages, including Python, Julia
and R, Colab currently only supports Python.

Colab notebooks are stored in a Google Drive account and can be shared
with other users, similar to other Google Drive files. The notebooks also
include an autosave feature, but they do not support simultaneous
editing, so collaboration must be serial rather than parallel.

Colab is free, but has limitations. There are some code types that are

forbidden, such as media serving and crypto mining. Available resources
are also limited and vary depending on demand, though Google Colab
offers a pro version with more reliable resourcing. There are other cloud
services based on Jupyter Notebook, including Azure Notebooks from

Microsoft and SageMaker Notebooks from Amazon.

Google Colaboratory

e Why Should You Use Google Colab?

Google Colab provides many exciting features that any modern |DE offers,
and much more. Some of the most exciting features are listed below.

« Pre-installed libraries:

Google Colab comes pre-installed with the most popular machine-learning
libraries. Colab comes pre-installed with Keras, PyTorch, and TensorFlow, which

saves you the time and hassle of setting up a local environment.
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« Saved on the cloud:

Every Notebook you create in the Google Google Colab is saved on the cloud.
This lets you access and work with those Notebooks from any machine. You only
need a browser and a reliable network connection, and you can work from
anywhere and anytime.

+ Collaboration:

Collaboration is another fantastic reason to choose Google Google Colab

when you are working on a project with a team of developers. You can share
your Notebook with your teammates and assign them roles so they can only
perform operations that fit their roles. The various options available for each

role is shown below:

Editors can change permissions and share — Viewers and commenters can
see the option to download, print, and copy

« Free GPU and TPU use:

Google Colab provides free access to GPUs and TPUs developed by
Google Research. So you can work on your projects with powerful GPUs
irrespective of your local machine.

mm‘bm
Fis B View Inset Rumtime Tools Help

# Code + Tem & Copy to Drive

' CO What is Colaboratory?
:MUW'MMMMWWMMWHYOWMW
= Zevo configuration required
+ Free acoess 10 GPUS

|« Essysharing
| mm.mnﬂ.mwnﬂm.Gdlbommhmrwukulllnmwmwlummu

| just get started below!

~ Getting started
ﬂummmmumlm-ﬂmmmmmmhmmmwmmwm
code.
For example, hete s 8 code call with a short Python script that computes & value, stores It in a varlable, and prints the resuit

| 1 sscondain_s_dey » 24 » 68 « 66
saconds_in_s_dey

To sxecuté the code in the above cull, select it with & click and then elther preas the play button 1o the left of the code, oF use the keyboard
shortcut *Command/Ctri+Enter”. To edit the code, just click the cell and star editing.
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S. Streamlit

Streamlit is a powerful and user-friendly open-source Python library that makes it
easier to build interactive web applications for machine learning and data science. With
Streamlit, developers and data scientists can create engaging, informative, and visually
appealing apps with just a few lines of code.

To install streamlit and import :
Ipip UnInstall streamlit

import streamlit as st
import pandas as pd
import matplotlib.pyplot as plt

One of the main benefits of Streamlit is its simplicity. You can write your code in
a familiar environment and use the library’s high-level APIs to quickly build complex
and interactive web applications. Whether you’re a seasoned software engineer or a
beginner in data science, Streamlit makes it easy to get started

Streamlit also offers a wide range of tools for creating data visualizations.
Whether you want to plot a scatterplot, display a histogram, or create a map, Streamlit
has you covered. You can even use it to build interactive dashboards that allow users

to explore your data in real-time.

Another benefit of Streamlit is its flexibility. You can use it to build apps for a
wide range of use cases, from simple data visualizations to complex machine learning
models. Streamlit even supports deployment, so you can easily share your apps with

others.

This code will create a web app that displays a line graph of xand y :

st.title("Line Plot e
data = pd.DataFrame ({
nen: [1, 2, 3, 4], # Load sample data
"y": [10, 20, 30, 40
L t(data["x"], data["y" # Plot the data

st.pyplot() Show the plot in the Streamlit app

When you run this code, Streamlit will create a new web page that you can interact
with. You can pan and zoom the plot, and you can use the Streamlit app to explore

your data in real-time.
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This example demonstrating some of Streamlit’s unique features, including :

« The slider component, slider allows you to choose a value within a specified
range by dragging a handle along a track. You can use sliders to select a number,
a date, or any other type of value.

num points = st.slider ("Number of points”, min value=100, max_value=1000,

value=500, step=100)

« The text input component, which updates in reai-time as the user types 4

st.write("The name :", text input)

« The checkbox component, a Checkbox is a toggle switch that allows the user to
turn an option on or off. You can use Checkboxes to allow the user to select

text input = st.text input("Enter some text:") '
multiple options. .

if not show_plot:

show plot = st.checkbox("Show plot", value=True)
plt.close() !

« The Select box component, a SelectBox allews you to choose one option from a

dropdown list. You can use Select Box to presznt a list =f options for the usc - to 'i
choose from. :
plot_color = st.selectbox("Plot color", ["blue", “red", "green"])
plt.plot (data("x"], data["y"]. color=plot_color) I
« The camera input helps to take a photo on the site . comes in handy when

deploying and using computer vision models .

st.camera input ("Take a picture")
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« You can display a progress bar in a Streamlit app . You can use this to display the
progress of a long-running task, such as a download or data processing.

1111

st.progress (progress_variable 1 to_100)

When everything done , this is how you launch it .

l - streamlit run app.py

b

g

Take the local URL and put it in chrome . There you go ,now you have your streamlit web

app up and running .

i
uuuq:;u{,

S

6. Github

GitHub is a developer platform that allows developers to create, store,
manage ard share their code. It uses Git software, providing the distributed
version control of Git plus access control, bug tracking, software
feature requests, task management, continuous integration, and wikis for every
project. Headquartered in California, it has been a subsidiary of Microsoft since

|
A\

XYy

2018.
Itis commonly used to host open source software development projects. As

of January 2023, GitHub reported having over 100 million developers and more
than 420 million repositories, including at least 28 million public repositories. It is

the world's largest source code host as of June 2023.
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AIM AND OBJECTIVES |

1. To Build DNA Nucleotide Cc::nt Web Application using
Google Colab.

2. The Main Objectives of these App is to determine the
precise order of the four nucleotide bases — adenine,
guanine, cytosine and thymine - that make up a strand

of DNA.

N — — — — —— -n
e ——————  —— e — — s ——— i —mmm e

3.To Count the amount of nucleotides (in a specific
sequence).

4. To contruct the result in form of tzble, series and in plot
frequency. I;'

5. These bases provide the underlying genetic basis (the Ii
genotype) for telling a cell what to do, where to go and l
what kind of cell to become (the phenotype).
Nucleotides are not the only determinants of
phenotypes, but are essential to their formation. Each

individual and organism has a specific nucleotide base

sequence.

(¥ Scanned with OKEN Scanner



4

uu&ﬁbbbhbbbhbb&&éééééééé%é(d(ZJ///

17|Page

MATERIAL AND
METHODS

MATERIALS:

e Google Colab Account :- https://colab.research.google.com/

e Python Compiler :- https://onecompiler.com/python or

et — | — | . e 4t

-
e ———
gyt ————— et R ——

https://www.online-python.com/
e GitHub Account for code repository : https://github.com/
e Streamlit Account to deploy App : https://share.streamlit.io/
e NCBI Link for getting DNA sequences of any species :-

httgs://www.ncbi.nIm.nih.gov[ or random dna sequence

generator :- molbiotools.com/randomsequencegenerator.php |l

e Computer with Internet Access
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METHODOLOGY

1. First step to open the google colab account.

How to use Colaboratory

To use Colaboratory, you must have a Google account.

On first we to \visit the google colab website -

https://colab.research.google.com/, to create an account and the
we will see a Welcome To Colaboratory notebook with links to

video introductions and basic information on how to use Colab.

PNNUUHBUGEU U b b e ddddddddddéidddeds
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Create a workbook

From the File menu, click New Notebook to create a workbook.

If you are not yet logged in to a Google account, the system will
prompt you to log in. The notebook will by default have a generic name;

click on the filename field to rename it.
m

File Edit View Insert Runtime Tools Help All changes saved

& MyFirstNotebook.ipynb
File Edit View Insert Runtime Tools Help

P Mada P Taud

The file type, IPYNB, is short for "IPython notebook" because IPython
was the forerunner of Jupyter Notebook.

The interface allows you to insert various kinds of cells, mainly text and
code, which have their own shortcut buttons under the menu bar via
the Insert menu. Because notebooks are meant for sharing, there are
accommodations throughout for structured documentation.

& MyFirstNotebook.ipynb
me Edit View Insert Runtime Tools Helpl All changi

+ Code + Text Code cell ®/Cul+M B
Text cell
° Section header cell

Scratch code cell 3®/Cri+Alt+N
Code snippets R/CrrlvAlt+P

Add a form field

BAANNNUUU UGG L 4§ 4 ddddieedden
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Code, debug, repeat

You can insert Python code to execute in a code cell. The code can be
entirely standalone or imported from various Python libraries.

A notebook can be treated as a rolling log of work, with earlier code
snippets being no longer executed in favor of later ones, or treated as an
evolving set of code blocks intended for ongoing execution. The
Runtime menu offers execution options, such as Run all, Run before or Run
the focused cell, to match either approach. Each code cell has a run icon on
the left edge, as shown above. You can type code into a cell and hit the run
icon to execute it immediately.

CO & MyFirstNotebool.ipynb L
File Edit View Insert  Runtime  Tools Help Allcheooes smmd .
+ Code + Yaxt Run el M/CTwreFD
Frun before W /Cuters
Aun selecth TSPt s nter

THRNINIRN

If the code generates an error, the error output will appear beneath
the cell. Correcting the problem and hitting run again replaces the error
info with program output. The first line of code, in its own cell, imports the
NumPy library, which is the source of the arange function. Colab has many
common libraries pre-loaded for easy import into programs.

o (2] Aimport numpy as np

a
ad
(=]

L (8] test_srray = np.avange(0,111,3)
test _arcay|sll])

arrayif 0, 3, 6, %, 12, 18, 18, 2}, 34, 27, 30))

I»irn.rn--b:luu-\voa
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Incorporating data into the notebook

After getting comfortable with the interface and using it for initial test
coding, you must eventually provide the code with data to analyze or
otherwise manupilate. Colab can mount a user's Google Drive to the VM
hosting their notebook using a code cell.

- - -
e o %

‘ ° from google.cola. import drive
| drive.mount('/my_ drive') I

— T ATt

—— i —

Once you hit run, Google will ask for permission to mount the drive.

Permit this notebook to access your Gocgle Drive files?

This notebook is requesting access to your Google Drive files. Granting access 1o
Google Drive will permit code executed in the notebook to madify files in your
Google Drive. Make sure 10 review notebook code prior to allowing this access.

No thenks  “onnect to Google Drive ll

If you allow it to connect, you will then have access to the filcs in
your Google Drive via the /my_drive path.

R EXPERRPPPPPPRPPrPrY

|
Save and share \

By default, Colab puts notebooks in a Colab Notebooks folder under My
Drive in Google Drive.

My Drive > Colab Notebooks ~

(" 1ype - | [ People - ) [ Modified - |
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: The File menu enables notebooks to be
| OHPERPTE saved as named revisions in the version

. | access to the notebook and to copy links.

X/CieP

TIZ] wewneenn history, relocated using Move, or saved
X ' Open notebook RICHHO | .
o .| Uplosd notebook as a copy in Drive or GitHub. It also allows
—J hof s T you to download and upload notebooks.
Move ,. Tools based on Jupyter provide broad
| e . compatibilities, so you can create
: o2 PN " notebooks in one place and then upload
| | Save a copy as a GitHub Gist h
| |  sevescopymonia L and use them in another.
i s ®/Curie .
' Save and pin revision mc:ﬂ.M: You can use the Share button in the
| sl upper right to grant other Google users
!

CLIITRNTN

2. Now the second step is to download required libraries in the

e —

google colab which are not preinstalled. i.e Streamlit.

For confirmation we will check the python version present on google colab.
By importing dash command in code tab - 'python -version

4

The result is as follows :

& Dna-App.ipynb
File Edit View Insert Runtime Tools Help

»

4+ Code <+ Text

(] tpython --version

{x} Pytnon 3.10.12

o) © [ipip -q install streamlit

D @ 8.4/8.4 MB 25.2 MB/s eta 9:00:00
198.6/199.6 kB 24.5 MB/s eta @:00:00
4.8/4.8 MB 56.5 MB/s eta 2:00:00
82.1/82.1 kB 11.1 MB/s eta @2:00:00
62.7/62.7 kB B.9 MB/s eta 9:00:82
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The Python version present is Python 3. 10. 12, and the notebook is
named as Dna-App.ipynb.

Now to Download the Streamlit Library, we have import pip
command in the code tabi.e, Ipip =q install streamlit |
h

When we run the code the library vi!l gct suc:essfully instlled.

3. In these step, we will construct the main framework of oui app_
i.e to type the code by importing reguired libraries/packages
that are required for our projec: jrom inz google colab.

In the code tab — Firstly we have to create the environment i.= .py
file to store the all imported libraries and modules (codes) which will

act as main framework to build our app.

These is done by typing the line in the code tab :-
$%writefile dna-app.pP¥y

Now the second step is to import required librarie~ for our app to wa.%in

the same code tab :-
import pandas as pd

import streamlit zz st
import altair as alt
from PIL import Image

e Thecommand import pandas as pd is used to import pandas
libraries which is useful for doing data modeling, data analysis and

data manipulat ion.
The command import streamlit as st isused toimport

streamlit from streamlit library. Streamlit helps to transform Python
scripts into interactive web apps. Build dashboards, generate reports,

or create chat apps.
The command import altair as alt isused toimport altair

library which is declarative visualization library for python, used for
data visualization or to display charts.
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e The Command from PIL import Image,the PIL stands for Python
Image Library is used to import the image module from the PIL library

to load the image.

After importing all the libraries and setting a particular environment, now

we can write a code in the same code tab :

image = Image.open('dna-logo.jpg"')
st.image (image, use column width=True)

st.write(““'|
#§ DNA Nucleotide Count Web App

This app counts the nucleotide composition of query DNA'!

LR

“l‘l“)
st.header ("Enter DNA sequence')

sequence_input = ">DNA Query
\nGAACACGTGGAGGCAAACAGGAAGGTGAAGAAGAACTTATCCTATCAGGACGGAAG
GTCCTGTGCTCGGG\nATCTTCCAGACGTCGCGACTCTAAATTGCCCCCTCTGAGGTC
AAGGAACACAAGATGGTTTTGGAAATGC\nTGAACCCGATACATTATAACATCACCAG i

CATCGTGCCTGAAGCCATGCCTGCTGCCACCATGCCAGTCCT"

sequence = st.text area("Sequence input", sequence_ input,
height=250)

sequence = sequence.splitlines()

sequence = sequence(l:]

sequence = ''.join(sequence)

TIIT77733717777777799)

st.write ("""
ok x

ﬂ"ll)

st.header (' INPUT (DNA Query)')
sequence

st .header ('OUTPUT (DNA Nucleotide Count)')

| -
l

\

1

SVESSSIITT
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*Next is the Print text —
st.subheader ('2. Print text')

adenine (A)')

773297

st.write('There are ' + str(X['A']) + '
st.write('There are ' + str(X['T']) + ' thymine (T)')
st.write('There are ' + str(X['G']) + ' guanine (G) ")
st.write('There are ' + str(X['C']) + ' cytosine (c)")

*The display data frame, which is in the table form =
st.subheader('3. Display DataFrame')

df = pd.DataFrame.from dict (X, orient="'index')
df = df.rename({0: 'count'}, axis='columns')
df.reset_index (inplace=True)

df = df.rename(columns = {'index':'nucleotide'})
st.write (df)

*The display bar chart, which display the results in th graph format —
st.subheader ('4. Display Bar chart')

p = alt.Chart (df) .mark_bar () .encode (

x='nucleotide’',

y="'count'

)
p = p.properties(
width=alt.Step (80) # controls width of bar.

)
st.write(p)

*After writing the above code in one code tab, we have to run that code
tab, by which the .py file i.e dna-app.py will get generated and saved in

the files menu.

& Dna-App.ipynb
File Edit View Insert Runtime Tools Help
+ Code + Text

TR

= Files 0O X
A
Q a c L&) = { 1 Ipython =-version
[—
Python 5.18.12

v B sample_data
[2] tpip -q install streamlit

Lol B dne-eppoy | < |
8.1/8.1 1

O
§3.8/53.4
195.4/19!
d.8a/4.8 1
B3.9/83 .1
62.7/82.°

LAY

XXwritefile dna-app.py

import pandas as pd
import streamlit as st
import altair as alt
from PIL import Image

v Os ocompleted ai 511 PM
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*The next step is to download the dna-app.py file and the supporting image i.e dna-
logo.jpg file in the computer.
*After downloading the files, save it to the specific folder.

4. To Deploy Web Application on Server

Firstly we have to open account on GitHub with the help of google account.

« After creating account, get login and create your profile.
. To deploy the app, we have to create a new public repository eg. dna-app.

Now add the files which we have downloaded i.e dna-app.py & dna-logo.jpg to
the new repository which is created (dna-app repository).

= () prdecosanep / dna-app Q Type jtosearch

<> Code O bsues 1N Pullrequests © Actions [0 Projects 0 wiki  © Security [+ Insights 8 Settings

i dna-app Public © Pin @ Unwarch 1

¥ main ~ ¥ 1Branch E}O‘ﬁgs Q Go to file t Add file = <> Code ~

“s* pradeepGanap Add files vis upload 2628447 - 2 months ago ) 3 Commit
2 months ago

[ READMEmd Initial commit

() dna-apppy Add files via upload 2 months ago
[ dna-ogojpg Add files via upload 2 months ago

1 README 7

dna-app

e Now to deploy the app publically, we have to create the account on Streamlit
(https://streamlit.io/) by the help GitHub, Streamlit provide us Community
Cloud to Deploy, manage, and share your apps with the world, directly from
Streamlit — all for free.

After creating account get login into the Streamlit and click on New Apps

VO VOV VU006 ddddddddddd

| The page appears i.e Deploy an app, fill all the information i.e Repository (Paste
’ GitHub URL), select Branch, Main file path and we can also set our own app URL

l and then click on Deploy.
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RESULTS

» DNA Nucleotide Count Web App Link :
https://dna-app-pradeepganap.streamlit.app/

@.&DNT
& =) W[E' By : Pr‘ageep

Aman

DNA Nucleotide Count Web App

Thit app counts the nucieotide co ition of guery DNAL

DNA Nucleotide Count Web App

Thet app counts the nuclectide composition of query DNA!

Enter DNA sequence

INPUT (DNA Query) -

We can enter any DNA sequence in the Sequence input box and press (ctrl +
enter) button to get the results.
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REFERENCES

» Basic of python by geeksforgeeks {gezksforgeeks.org/whet-
is-python/) = what is python? , what-is-the-difference- |
between-pythons-module-package-and-library? |

|

pythons-module-package-and-library/amp/), and Python
doc/essay/blurb by (python.org/doc/essays/blurb/)

» How to use google colab

(geeksforgeeks.org/what-is-the-difference-between- 1
|
(research.google.com/colaboratory/fag.html), google colab |
topics by scaler (scaler.com/topics/what-is-google-colab/), |
How to use google «colab by techtarget |
(techtarget.com/searchenterpri:eai/tutorial/Why-and- .
how-to-use-Google-Colab) |
» GitHub  Account tutorial (docs.github.com/en/get-
started/onboarding/getting-started-with-your-github-
account)
» Streamlit tutorial by medium blog (medium.com/data-and-

beyond/streamlit-d357935b9c) and (docs.streamlit.io/get-

started/installation#install-streamlit-on-windows)
» JCharis Jesse (github.com/Jcharis/DataScienceTools)

» How to launch streamlit app from gcogle colab notebock

(discuss.streamlit.io/t/how-to-launch-streamlit-app-from-
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FUTURE PROSPECTS

» Generally these web application is used for counting the number

of all four nucleotides and finding the percentage number of

each of them which is to help students, professors and experts

in the field of biological sciences to count nucleotide
composition of DNA!

» In Future Research, we are developing the web application
which is based on the principle of Central Dogma.

» These new version app will contain the various tools such as to
count DNA nucleotide count (same as the perious app), The tool
which covert DNA sequence into Replicate DNA sequence, It will
also consist of the tool to covert DNA sequence into mRNA
sequence (i.e Transcription), The will also have the features to
covert the generated mRNA sequence into the Amino Acid
sequence (i.e Translation mRNA is converted into Amino Acid
sequence) and these all results will be in the form of print

dictionary, print text, plot frequency, in table format, and in the

form of bar chart.

» This program made are specifically for studies made with

genetics and organisms in microbiology such as viruses or

bacterias.
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